Making Your First Ma !
Fall 2023 \;g\/orkshops P S(HOI'ARS I'AB

Drew MacQueen Chris Gist
GIS Specialist GIS Specialist
dmacqueen@yvirginia.edu cgist@yvirginia.edu

Today we’ll map Charlottesville using free datasets from the City of Charlottesville and the US
Census. UVa licenses ArcGIS Pro through named user accounts in ArcGIS Online. In order to
use Pro, you'll first need to create an ArcGlIS Online account.

https://at.virginia.edu/2Hp | pyY

First, let’s open ArcGlIS Pro. Click the Start Menu
button. In the search at the bottom of the Start Sign In
Menu, type “ArcGIS Pro”’, and click ArcGIS

Pro to open. You will first be prompted to login
to an ArcGlIS Online account to access your Password
ArcGIS Pro license. In the sign in dialog, click

Enterprise Login. For the organization URL,

Username

Keep me signed in

type “uvalibrary”’, and click Continue. Click
University of Virginia. You will be directed to Forgot password? ~Forgot username?
NetBadge where you will login as normal. o

Signin Wilhl‘ ENTERPRISE LOGIN ‘
Sign in with “ G

Sign In @esri Sign in to University of Virginia @esri

UNIVERSITY OF VIRGINIA

ARCGIS

Enter your ArcGIS organization's URL below.

uvalibrary| maps.arcgis.com

< BACK ool RRIyiv]=

Welcome to ArcGIS Pro! If this is your first time using the software, you’ll see an empty
project list. In Pro, we can create projects that contain multiple maps, layouts, and even 3D
scenes.



https://myuva-my.sharepoint.com/personal/aam6g_virginia_edu/Documents/Teaching/Workshops/2018_Fall/dmacqueen@virginia.edu
mailto:cgist@virginia.edu

To begin, click the Blank template in the Create a
A 'C GIS P O new project pane. Give the new project a useful

name, accepting the default location. Be sure the

box for “Create a new folder for this project”

Create a new project is checked.

Select a template to use to create a new project

Blank Global_Scene.aptc  Local_Sceneaptx

Making a Neighborhood Map of Charlottesville
We're going to add data layers from ArcGIS

Home Insert Analysis View

Online. But first we need to create a map.
. . =5 New Layout ~ Toolbox - ¢ Add - -+
|. Click the Insert tab, and click New . .
@ Import Map &% Add Folder G2 Mew -
Map. _ _ Add
¥ Connections - @l Task = o Import | tem -
A new map named “Map” is added to your Project Styles  Favorites
project and opened. Let’s give it a useful name.
2. To the right of your project, you should see the
Catalog * X

Catalog Pane. If you don’t see this, click the
Insert tab and click Catalog Pane. Expand Project | Portal | Favorites | History =
the Maps section, right click “Map” and click

Rename. Type “Cville Neighborhoods”. SEarn R

4 gl Maps

Note: There is a Catalog Pane that appears on the B | Cuileaighborood:

right side of the project. There is also a Catalog View

that appears as a window in the main area with the & Toolboxes

CVille Neighborhoods map. They function very 5l Databases

similarly. o7 Styles

Folders
3. Click the Add Data button, on the Map ﬁ .

ribbon. We want to search for layers on UVA’s A
ArcGlIS Online site. Under Portal select All Portal. On the top, far right of Data ~
the dialog, click Search My Organization.

4. In the search box, type

| Search Result for 'FirstMap' » (0] |Fir5t|‘»-'lap X '|

“FirstMap”’ and hit Enter. Click + DA
Workshop_FirstMap, and click L
OK MNarne Type Date

| 9 Workshop_FirstMap Feature Layer (Hos 1/22/2019 1:06 PM
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This adds a feature service to your project. If you click to expand Workshop_FirstMap,
you’ll see that this service contains two layers, Census Block Points and Neighborhoods. With
the proper privileges, you have the ability to manipulate ArcGIS Online layers and edit their
geometries and attributes in Pro. You don’t have those privileges on these layers, but you can
make them your own my saving them to your project database.

First, let’s label the Neighborhoods so that we can identify them.

5. Click on the Neighborhoods_CVille layer to highlight it, then click the Labeling tab.

6. Click Label on the far left of the ribbon to enable the labels. Make sure Name is

selected for the labeling Field. /

m Map Insert Analysis View Edit Imagery Share Appearance Labeling Data

v Class | Class1 = %_I e In Beyond <Mone> . .
fﬁ [/] Label Features In This Class ~|’:.OutBE}-'cm:I <Mones> - AA . = ) e ) -
abel e mps IEI A Boundary Landform/P... Landmarky... - 5:._‘_:-“;_10 ogy -~ 0 x
Layer abel Class Visibility Range Text Symbol Z L_l # "TIEI =
Primary symbology
How did the GIS find the neighborhood names? Right click the Cville  [uniauevaiue:
Neighborhoods layer and choose Attribute Table. Field 1 NAME :
Each GIS layer can have many attributes. Our labels came from the —
Name attribute. These names were created by the Charlottesville GIS
Analyst who built this and many other layers. Now, close the attribute | e [sca
table_ / EW W More =
Symbci Value Label
7. Let’s assign a unique color to each neighborhood. v NAME o values ¢
Click the Neighborhoods layer to highlight it, click v : ki ol i
. Barracks Road Barracks Road
the Appearance tab and click Symbology. In SRR
. . bl I:l Barracks/Rughby Barracks/Rugk
the Symbology dialog, change the option from = R— S
Single Symbol to Unique Values. Make sure Fieldl is set to TR Fitevile
Name. Choose a Color Scheme, then click the Add All Values B ryssping  Fy'sSpring
button to symbolize all values B Greenbrier  Greenbrier
] Jefferson Park A... Jefferson Park
. - Johnson Village  Johnson Villag
8. Save your work often. Click the Save button on the top left, or B tewswn .
CliCk PI"Oject > Save. - Locust Grove Locust Grove
- Martha Jefferson  Martha Jeffers
[l Morth Downtown  North Downtg
= Ridge Street Ridge Street
_ [ | Rose Hill Rose Hill
= Starr Hill Starr Hill
- I:l The Meadows The Meadows
Project Ma Insert
FI - Venable Venable
] Woolen Mills Woaolen Mills

v <all other values>

- <all other value... <all otherval
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l Charlottesville Neighbbrhoods

16 Miles
i J

Next we’ll get our map ready to export as a
.jpg, -png or .pdf to insert in a report,
presentation, or email.

9. Click the Insert tab. Click New Layout,
and choose Letter.

10. Click Map Frame and select CVille
Neighborhoods. This puts our map on a virtual
8.5 x | | sheet of paper.

I'l. If you need to change the zoom or pan of
the map, click Activate, then move the map
to the proper position. When done, click the
Layout tab, and click Close Activation.

[2. Click the Insert tab and use the Map
Surrounds section to add text, scale bar,

North arrow, etc.

|3. Now we’re ready to export our map so

we can insert it in a presentation, report or email. Click the Share tab, and in the
Export section, click Layout. Change Save as type: to the type of file you want to
create, .jpg, .png, or .pdf are commonly used.

|4. Browse to an appropriate folder and give your exported map the file name
CvilleHoodsMap. Click Export to export your map. Use Windows to browse to the
folder and open your finished map.

I5. Click the Save button to save your map, layout and project. Close the map and layout.

Congratulations cartographer! You’ve just made a customized map using Geographic

Information Systems software.

Making a Neighborhood Population Map - Graduated Colors

Even if using the same data, it’s good practice to create a new map when representing that
data in a different way. This way, you can go back and make incremental changes to your map

without having to re-create it.

Since we’ll be using the same data as before, let’s create a copy of our CVille Neighborhoods
map in the Catalog Pane or Catalog View. To view the Catalog Pane, click the Catalog tab on
the bottom of the right-hand pane section. Or, click the View tab and click Catalog Pane.
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Catalog -1 x |. In Catalog, expand Maps, right-click the Cville
profect | Portal | Eavorites | Hist — Neighborhoods map, and click Copy. Then, right-click
roject | Portal | Favorites | Histon = .
— 5 Maps and click Paste.
“| @ _Veps | 2. Renamethe Map “Cville Pop”. Right-click the

[E q & NewMep Cville Pop map and click Open.

2
Too| &5 Mew Global Scene

Dot ill New Local Scene Look familiar? It’s an exact copy of our CVille
Neighborhoods map. Let’s change that! You’ll recall
that, when we viewed the Neighborhoods attribute
table, it only contained the neighborhood names, no
population information. Thanks to the power of GIS, we
can fix that by aggregating the block point information

with the neighborhoods.

= Laya |_—| Mew Stereo Map

Sple oo Mew Basemap

= Fold ‘E Paste
&1 Loc: Irnport

Catalog | Symbology Element

Geoprocessing > 1 X
3. In the Table of Contents, click the box next to the ® Spatial Join =
CensusBlockPoints layer to make it visible. - o
arameters ErVIFroNmMents
Target Features
These points show the center of each 2010 US Census Neighborhoods_CVille -
. ’ . . Join Features
Block. Open this layer’s attribute table to see population T .
values. To summarize the population count from the Output Feature Class
Census Block layer into our Neighborhood layer we'll usea  “=omereesersee
. . . oin Uperation
powerful process unique to GIS, the Spatial Join. Join one to one -
O Keep All Target Features
4. Close all the attribute tables. Click the box next to riekd Mep ot Join Festures =
. IR n utput Fields (+) S Properties
CensusBlockPoints to turn off visibility of these Ouiput ek (& e
] MNAME verge Rule |Sum -
oints. : -
P Shape_Area CensusBlockPoints201(
Shape_ Length totpop -
5. Right click the Neighborhoods layer and click Joins geiol5
. . . geodisplay Add Mew Source v
and Relates > Spatial Join. Set up the Join Data —
dialog box like the picture. We want to summarize pys—
Total Population, so be sure to select totpop and set blackpop
Merge Rule to Sum. amindpop
asianpop
. islanderpo
6. Click OK to create the new layer. Once complete, therpop
the new layer is added to your map. Match Option
Intersect -
. . . . Search Radius
7. Right-click NeighborhoodPopulation and open the Feet -

attribute table.

The GIS has summarized the total population for each neighborhood. Now we have the
population numbers we need to make a thematic population map of the neighborhoods.
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8. Turn off all layers except Symbology - Neighborhoods_CVille_...

NeighborhoodPopulation and close all attribute

tables. Right-click the new layer and click Label. A% 5 £

. . . . . Primary symbology
9. Right click NeighborhoodPopulation and click

Symbology. Set up the Layer Symbology dialog

Graduated Colors

Field tot,
as shown. =P
Mormalization | <MNonex
10. Now the neighborhoods are coded by color Methed Natural Breaks Lenks)
showing Total Population low to high. L 5

« 1 X

Colorscheme | B -

In this case, we only got the sum of the total population
field. The tool allows us to aggregate the points and Classes | Histogram | Scales
attributes in a number of ways, all of which can be

mapped and symbolized to visualize differences and

Symbo Upper value =
disparities. < 5490

= 14585.0
Feel free to add labels to this layer as before. You can = P
also create a layout containing the typical map elements = R—
we used in the previous example. However, ArcGIS R p—

Pro allows us to take advantage of the cloud sharing
capability of ArcGIS Online.

ArcGIS Online

Labei

=549,000000

=1499,000000

£3214.,000000

£4673.000000

£7257.000000

More =

ArcGlIS Online is an excellent platform for spatial data sharing. It allows you share your data
with the world, or with specific people. You can use AGOL to collaborate around spatial data,

and collectively contribute to the creation and modification of data layers.

|. Right click the NeighborhoodPopulation layer, click Sharing, and click Share as

Web Layer.
2. Enter a Summary of your layer, and enter at least one Tag.
3. Click Publish.

You’ve now published your own feature layer to ArcGIS Online. Let’s view it in your Content.

|. Go to: https://uvalibrary.maps.arcgis.com/home/signin.html
2. Click University of Virginia

3. Sign in using your NetBadge credentials.
4. Click Content to view your content.
5. Click NeighborhoodPopulation to view information about your layer.

UNIVERSITY OF VIRGINIA
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